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Πρόσθετα βοηθήματα 
από την Learn by Video 
Ένα πρόσθετο δίωρο με βοηθή-
ματα της Learn Dreamweaver CS5 
by Video περιλαμβάνεται σ' αυτό 
το δίσκο, από την video2brain 
και την Adobe Press. Το προϊόν 
Learn by Video είναι ένα από τα 
πιο ευρέως αποδεκτά εκπαι-
δευτικά έργα για λογισμικό της 
Adobe και είναι η μοναδική σειρά 
μαθημάτων σε βίντεο που έχουν 
δεχθεί την έγκριση της Adobe με 
την πιστοποίηση Adobe Certified 
Associate Level.

ΤΙ ΥΠΑΡΧΕΙ ΣΤΟ ∆ΙΣΚΟ 

Ακολουθεί μια περίληψη των περιεχομένων του δίσκου που συνοδεύει το βιβλίο

Ο δίσκος που συνοδεύει το βιβλίο περιλαμβάνει τα αρχεία μαθημάτων που θα χρειαστείτε για 
την ολοκλήρωση των ασκήσεων που υπάρχουν στο βιβλίο, όπως και άλλο υλικό που θα σας 
βοηθήσει να μάθετε περισσότερα για το λογισμικό, ώστε να το χρησιμοποιείτε με μεγαλύτερη 
αποτελεσματικότητα και ευκολία. Το παρακάτω διάγραμμα παρουσιάζει τα περιεχόμενα του 
δίσκου, τα οποία θα πρέπει να σας βοηθήσουν να εντοπίσετε τα αρχεία που χρειάζεστε.

Αρχεία μαθημάτων
Κάθε μάθημα έχει τον δικό του φάκελο 
μέσα στο φάκελο Lessons. Θα πρέπει 
να αντιγράψετε αυτούς τους φακέλους 
μαθημάτων στον σκληρό δίσκο σας 
πριν ξεκινήσετε κάθε μάθημα.

Ηλεκτρονικοί πόροι
Συνδέσεις για τη σελίδα 
βοήθειας της Adobe Com-
munity, σελίδες βοήθειας και 
υποστήριξης, Adobe Press, 
προγράμματα πιστοποίησης 
της Adobe, Adobe TV και 
άλλους χρήσιμους ηλεκτρο-
νικούς πόρους, θα βρείτε 
μέσα σε ένα χρηστικό αρχείο 
HTML. Απλά ανοίξτε το στο 
πρόγραμμα περιήγησής σας 
στο Web και κάντε κλικ στις 
συνδέσεις – συμπεριλαμβά-
νεται μια ειδική σύνδεση για 
τη σελίδα αυτού του βιβλίου, 
όπου θα μπορείτε να προ-
σπελάσετε ενημερώσεις και 
πρόσθετο υλικό.

Α
Κ

Ηλ

Adobe, the Adobe logo, Classroom in
 a Book and D

re
am

wea
ve

r a
re

 tr
ad

em
ar

ks
 o

f A
do

be
 S

ys
te

m
s 

In
co

rp
or

at
ed

. M
ac

 O
S 

is
 a

 tr
ad

em
ar

k 
of

 A
pp

le
, r

eg
ist

er
ed

 in
 th

e U
.S. a

nd other c
ountrie

s. W
indows is either a registered  trademark or a trademark of Microsoft  Corporation in the U .S. and/or other countries. CLASSROOM IN A BOOK®

ADOBE® DREAMWEAVER® CS5
WINDOWS®/MAC OS®

© 2010 Adobe Systems Incorporated
All rights reserved. Made in the USA.
ISBN-13: 978-0-321-70177-0
ISBN-10: 0-321-70177-1
5/10

00_CONTENTS dream-cs4.indd   iii00_CONTENTS dream-cs4.indd   iii 18/10/2010   6:00:24 μμ18/10/2010   6:00:24 μμ



ΕΙΣΑΓΩΓΗ  xi

Σχετικά με το Βήμα προς βήμα .........................................................................xi

Προϋποθέσεις .................................................................................................xi

Εγκατάσταση του προγράμματος .....................................................................xii

Αντιγραφή των αρχείων του βιβλίου ............................................................... xii

Προτεινόμενη σειρά μαθημάτων  .................................................................... xiii

Γρήγορη εκκίνηση .......................................................................................... xiii

∆ιαμόρφωση του χώρου εργασίας ..................................................................xiv

Οδηγίες για Windows και Macintosh ...............................................................xv

Πώς θα βρείτε πληροφορίες για το Dreamweaver ...........................................xv

Έλεγχος για ενημερώσεις ..............................................................................xv

Πρόσθετοι πόροι  ...........................................................................................xvi

Πιστοποίηση από την Adobe ......................................................................... xviii

Επιταχύνετε τη ροή εργασίας σας με το Adobe CS Live .................................xix

1  ΠΡΟΣΑΡΜΟΓΗ ΤΟΥ ΧΩΡΟΥ ΕΡΓΑΣΙΑΣ 2

Ξενάγηση στο χώρο εργασίας  .........................................................................4

Εναλλαγή και διαχωρισμός προβολών ..............................................................5

Εργασία με παλέτες .........................................................................................7

Επιλογή διάταξης χώρου εργασίας  ................................................................11

Προσαρμογή γραμμών εργαλείων ..................................................................13

Εξατομίκευση προτιμήσεων ...........................................................................14

∆ημιουργία προσαρμοσμένων συντομεύσεων πληκτρολογίου ........................14

Χρήση του Property inspector .........................................................................16

ΠΙΝΑΚΑΣ ΠΕΡΙΕΧΟΜΕΝΩΝ

00_CONTENTS dream-cs4.indd   iv00_CONTENTS dream-cs4.indd   iv 18/10/2010   6:00:25 μμ18/10/2010   6:00:25 μμ



2  ΤΑ ΒΑΣΙΚΑ ΤΗΣ HTML  20

Τι είναι η HTML;  ............................................................................................22

Από πού ξεκίνησε η HTML;  ...........................................................................22

Σύνταξη του δικού σας κώδικα HTML .............................................................23

Κωδικοί HTML που χρησιμοποιούνται συχνά  ................................................  31

Ποιο είναι το μέλλον της HTML;  ....................................................................34

3  ΤΑ ΒΑΣΙΚΑ ΤΩΝ CSS  36

Τι είναι CSS; ..................................................................................................38

Μορφοποίηση HTML εναντίον μορφοποίησης CSS .........................................39

Μοντέλο κουτιού CSS ....................................................................................41

Προεπιλογές της HTML .................................................................................42

Μορφοποίηση κειμένου  .................................................................................44

Μορφοποίηση αντικειμένων ...........................................................................47

Πολλαπλά στοιχεία, κλάσεις και ID -- φτάνει! .................................................50

4  ΓΡΗΓΟΡΟ ΞΕΚΙΝΗΜΑ  54

Ορισμός ενός site στο Dreamweaver ..............................................................56

Χρήση της οθόνης υποδοχής  ........................................................................58

Επιλογή διάταξης CSS ...................................................................................59

Αποθήκευση σελίδας  ....................................................................................60

Τροποποίηση τίτλου σελίδας..........................................................................60

Αλλαγή επικεφαλίδων ....................................................................................60

Εισαγωγή κειμένου ........................................................................................61

Εισαγωγή εικόνων  .........................................................................................63

Επιλογή και τροποποίηση στυλ CSS ...............................................................66

Προσαρμογή γραμματοσειρών, χρωμάτων και μεγεθών κειμένου  ..................70

Χρήση του Property inspector .........................................................................73

Προεπισκόπηση μιας σελίδας στην προβολή Live ...........................................75

Προεπισκόπηση σελίδων σε πρόγραμμα περιήγησης .....................................76

vΠίνακας περιεχομένων

00_CONTENTS dream-cs4.indd   v00_CONTENTS dream-cs4.indd   v 18/10/2010   6:00:26 μμ18/10/2010   6:00:26 μμ



5  ∆ΗΜΙΟΥΡΓΙΑ ∆ΙΑΤΑΞΗΣ ΣΕΛΙ∆ΑΣ 80

Βασική θεωρία σχεδίασης web.......................................................................82

Εργασία με μικρογραφίες και wireframes .......................................................84

Προεπισκόπηση του ολοκληρωμένου αρχείου σας .........................................88

Τροποποίηση υπάρχουσας διάταξης CSS .......................................................88

Προσθήκη εικόνας φόντου στην επικεφαλίδα .................................................91

Εισαγωγή νέων στοιχείων <div>  .................................................................93

Τροποποίηση του πλάτους και του χρώματος φόντου της σελίδας .................96

Τροποποίηση υπάρχοντος περιεχομένου και μορφοποίησης ..........................97

Εισαγωγή στοιχείου υποκατάστασης θέσης εικόνας  ...................................100

Εισαγωγή στοιχείου υποκατάστασης θέσης κειμένου ...................................101

Τροποποίηση του υποσέλιδου  ....................................................................  101

Έλεγχος συμβατότητας προγραμμάτων περιήγησης  .................................. .102

6  ΕΡΓΑΣΙΑ ΜΕ ∆ΙΑ∆ΟΧΙΚΑ ΦΥΛΛΑ ΣΤΥΛ 104

Προεπισκόπηση ολοκληρωμένου αρχείου ...................................................  106

Εργασία με την παλέτα CSS Styles  ..............................................................106

∆ημιουργία νέων κανόνων CSS ................................................................... .110

∆ημιουργία διαλογικού μενού ..................................................................... .115

Τροποποίηση συμπεριφοράς υπερσυνδέσεων  ............................................ .118

∆ημιουργία ψεύτικων στηλών .......................................................................121

Μετακίνηση κανόνων σε ένα εξωτερικό φύλλο στυλ  ...................................123

∆ημιουργία φύλλων στυλ για άλλους τύπους μέσων   ...................................124

7  ΕΡΓΑΣΙΑ ΜΕ ΠΡΟΤΥΠΑ  132

Προεπισκόπηση ολοκληρωμένων αρχείων ..................................................  134

∆ημιουργία προτύπου από υπάρχουσα διάταξη  ..........................................  135

Εισαγωγή επεξεργάσιμων περιοχών ..........................................................   137

Παραγωγή θυγατρικών σελίδων  .................................................................  138

Ενημέρωση προτύπου .................................................................................  141

Χρήση στοιχείων βιβλιοθήκης ......................................................................  144

Χρήση include διακομιστή ............................................................................  149

Πίνακας περιεχομένωνvi   

00_CONTENTS dream-cs4.indd   vi00_CONTENTS dream-cs4.indd   vi 18/10/2010   6:00:30 μμ18/10/2010   6:00:30 μμ



8  ΕΡΓΑΣΙΑ ΜΕ ΚΕΙΜΕΝΟ, ΛΙΣΤΕΣ ΚΑΙ ΠΙΝΑΚΕΣ  158

Προεπισκόπηση ολοκληρωμένου αρχείου ...................................................  160

Εισαγωγή κειμένου  .....................................................................................162

∆ημιουργία τίτλων ........................................................................................163

∆ημιουργία λιστών. ......................................................................................165

∆ημιουργία εσοχών κειμένου  ......................................................................167

∆ημιουργία και απόδοση στυλ σε πίνακες ....................................................170

Ορθογραφικός έλεγχος ιστοσελίδων...........................................................  184

Εύρεση και αντικατάσταση κειμένου ............................................................185

9  ΕΡΓΑΣΙΑ ΜΕ ΕΙΚΟΝΕΣ  190

Επανάληψη βασικής θεωρίας εικόνων στο web ............................................192

Προεπισκόπηση του ολοκληρωμένου αρχείου  .............................................196

Εισαγωγή εικόνας .......................................................................................  197

Προσαρμογή θέσεων εικόνων με κλάσεις CSS  ...........................................199

Εργασία με την παλέτα Insert  ......................................................................201

Χρήση του Adobe Bridge ..............................................................................202

Εισαγωγή ασύμβατων τύπων αρχείων   .........................................................204

Εργασία με τα έξυπνα αντικείμενα του Photoshop .......................................207

Αντιγραφή και επικόλληση εικόνων από τα Fireworks και Photoshop  ...........209

Εισαγωγή εικόνων με μεταφορά και απόθεση  .............................................  211

Βελτιστοποίηση εικόνων με το Property inspector  .......................................212

10  ΕΡΓΑΣΙΑ ΜΕ ΠΛΟΗΓΗΣΗ  216

Τα βασικά για τις υπερσυνδέσεις .................................................................218

Προεπισκόπηση του ολοκληρωμένου αρχείου σας  ......................................219

∆ημιουργία εσωτερικών υπερσυνδέσεων ....................................................  222

∆ημιουργία σύνδεσης εικόνας  ....................................................................225

∆ημιουργία εξωτερικής σύνδεσης  ..............................................................226

Προετοιμασία συνδέσεων ηλεκτρονικού ταχυδρομείου  . ............................  227

Στόχευση στοιχείων σελίδας  .......................................................................229

Εισαγωγή γραμμών μενού Spry ...................................................................  232

Εισαγωγή μενού Spry ως στοιχείου βιβλιοθήκης  ........................................  250

Έλεγχος της σελίδας σας ...........................................................................  254

viiΠίνακας περιεχομένων

00_CONTENTS dream-cs4.indd   vii00_CONTENTS dream-cs4.indd   vii 18/10/2010   6:00:31 μμ18/10/2010   6:00:31 μμ



11  ΠΡΟΣΘΗΚΗ ∆ΙΑΛΟΓΙΚΟΤΗΤΑΣ  258

Μάθετε τις συμπεριφορές του Dreamweaver   .............................................260

Προεπισκόπηση ολοκληρωμένου αρχείου ...................................................  261

Εργασία με τις συμπεριφορές του Dreamweaver  .........................................263

Εργασία με τα εργαλεία του Spry Accordion  ...............................................269

12  ΕΡΓΑΣΙΑ ΜΕ ΤΟ FLASH  276

Τι είναι το Flash ..........................................................................................  278

Προεπισκόπηση ολοκληρωμένου αρχείου ...................................................  278

Προσθήκη κίνησης του Flash σε σελίδα  ......................................................  279

Προσθήκη αρχείου FLV σε σελίδα ...............................................................  283

13  ΕΡΓΑΣΙΑ ΜΕ ΦΟΡΜΕΣ  288

Προεπισκόπηση ολοκληρωμένου αρχείου ...................................................  290

Μάθετε για τις φόρμες ...............................................................................  292

Προσθήκη φόρμας σε σελίδα  .....................................................................  293

Εισαγωγή στοιχείων φόρμας κειμένου .........................................................  295

Εισαγωγή πλαισίων ελέγχου ...................................................................... . 304

∆ημιουργία ραδιοφωνικών κουμπιών  ..........................................................  306

Εργασία με λίστες .......................................................................................  309

Προσθήκη κουμπιού υποβολής ................................................................... . 311

Καθορισμός ενέργειας φόρμας  ..................................................................  313

Αποστολή δεδομένων φόρμας με ηλεκτρονικό ταχυδρομείο  ......................  315

Απόδοση στυλ σε φόρμες ...........................................................................  319

14  ΕΡΓΑΣΙΑ ΜΕ ∆Ε∆ΟΜΕΝΑ ΣΤΟ WEB  324

Εργασία με δυναμικό περιεχόμενο   .............................................................326

Προεπισκόπηση του ολοκληρωμένου αρχείου  ............................................ .326

Χρήση δεδομένων HTML και XML ................................................................328

Επιλογή μοντέλου διακομιστή ......................................................................338

Ρύθμιση παραμέτρων τοπικού διακομιστή web   ...........................................340

∆ημιουργία διακομιστή δοκιμών ...................................................................340

Κατασκευή εφαρμογών βάσεων δεδομένων   ...............................................343

Πίνακας περιεχομένωνviii   

00_CONTENTS dream-cs4.indd   viii00_CONTENTS dream-cs4.indd   viii 18/10/2010   6:00:33 μμ18/10/2010   6:00:33 μμ



ixΠίνακας περιεχομένων

15  ΚΑΤΑΣΚΕΥΗ ∆ΥΝΑΜΙΚΩΝ ΣΕΛΙ∆ΩΝ ΜΕ ∆Ε∆ΟΜΕΝΑ  352

Κατασκευή σελίδων με ASP, ColdFusion ή PHP  ..........................................  354

∆ημιουργία ομάδων κύριων/αναλυτικών σελίδων  .......................................  363

∆ημιουργία αναλυτικών σελίδων.  ................................................................374

16  ΕΡΓΑΣΙΑ ΜΕ ΚΩ∆ΙΚΑ  380

Περίληψη εργαλείων κώδικα ........................................................................382

Επιλογή κώδικα  ..........................................................................................  383

Σύμπτυξη κώδικα .........................................................................................384

Ανάπτυξη κώδικα .........................................................................................385

Προσθήκη νέου κώδικα ...............................................................................  386

Χρήση του Code Navigator ............................................................................388

Προσπέλαση ζωντανού κώδικα .....................................................................389

Χρήση κατάστασης επιθεώρησης ................................................................  391

Εργασία με σχετικά αρχεία. ......................................................................... .392

Προσπέλαση προβολής Split Code ..............................................................  393

Σχολιασμός κώδικα ......................................................................................393

17  ∆ΗΜΟΣΙΕΥΣΗ ΣΤΟ WEB  396

Ορισμός απομακρυσμένου site  ....................................................................398

Απόκρυψη φακέλων και αρχείων .................................................................  405

Τακτοποίηση ...............................................................................................  407

Μεταφορά του site στο web ........................................................................  410

Συγχρονισμός τοπικών και απομακρυσμένων site  ........................................413

 ΕΥΡΕΤΗΡΙΟ  416

00_CONTENTS dream-cs4.indd   ix00_CONTENTS dream-cs4.indd   ix 18/10/2010   6:00:39 μμ18/10/2010   6:00:39 μμ



ΕΙΣΑΓΩΓΗ

Το Adobe® Dreamweaver® CS5 είναι ένα πρωτοπόρο πρόγραμμα δημιουργίας 
ιστοσελίδων. Είτε το επάγγελμά σας αφορά στη δημιουργία websites, είτε 
είναι κάτι που κάνετε γιατί σας αρέσει, το Dreamweaver σας προσφέρει όλα 
τα εργαλεία που χρειάζεστε, ώστε τα αποτελέσματά σας να χαρακτηρίζο-
νται από επαγγελματική ποιότητα.

Σχετικά με το Βήμα προς βήμα
Το Adobe Dreamweaver CS5 Βήμα προς Βήμα αποτελεί κομμάτι της εκπαιδευ-
τικής σειράς για προγράμματα γραφικών και εκδόσεων Adobe που αναπτύσ-
σονται με την υποστήριξη ειδικών της Adobe. Τα μαθήματα σχεδιάζονται έτσι 
ώστε να μπορείτε να προχωράτε με το δικό σας ρυθμό. Αν είστε αρχάριοι 
στο Dreamweaver, θα μάθετε τις βασικές έννοιες που είναι απαραίτητες 
προκειμένου να λειτουργήσετε σωστά το πρόγραμμα. Αν χρησιμοποιείτε 
ήδη το πρόγραμμα, θα διαπιστώσετε ότι αυτό το βιβλίο σας διδάσκει πολλά 
εξειδικευμένα χαρακτηριστικά και συμπεριλαμβάνει συμβουλές και τεχνικές 
για τη βέλτιστη χρήση της νέας έκδοσης του Dreamweaver.

Κάθε μάθημα παρέχει οδηγίες σε μορφή βημάτων για τη δημιουργία συγκεκρι-
μένων έργων, υπάρχει όμως αρκετός χώρο για εξερεύνηση και πειραματισμό. 
Μπορείτε να ακολουθήσετε το βιβλίο από την αρχή ως το τέλος, ή μπορείτε 
να ασχοληθείτε μόνο εκείνα τα μαθήματα που αντιστοιχούν στα δικά σας 
ενδιαφέροντα και τις δικές σας ανάγκες. Κάθε μάθημα ολοκληρώνεται με 
μία ενότητα ανασκόπησης που συνοψίζει ό,τι μάθατε.

Προϋποθέσεις
Πριν ξεκινήσετε να χρησιμοποιείτε το Adobe Dreamweaver CS5 Βήμα προς 
Βήμα, θα πρέπει να γνωρίζετε πώς λειτουργεί ο υπολογιστής σας και το 
λειτουργικό σύστημά του. Θα πρέπει να γνωρίζετε πώς να χρησιμοποιείτε 
το ποντίκι και τα βασικά μενού και εντολές και επίσης πώς να ανοίγετε, να 
αποθηκεύετε και να κλείνετε αρχεία. Εάν πρέπει να κάνετε μία επανάληψη 
σε αυτές τις τεχνικές, διαβάστε την έντυπη ή την ηλεκτρονική τεκμηρίωση 
που συμπεριλαμβάνεται στο λειτουργικό σύστημά σας Microsoft Windows 
ή Apple Macintosh.
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Εγκατάσταση του προγράμματος
Πριν εκτελέσετε οποιαδήποτε άσκηση του βιβλίου, βεβαιωθείτε ότι το 
σύστημα του υπολογιστή σας πληροί τις απαιτήσεις υλικού για το Dream-
weaver CS5, το οποίο έχετε ρυθμίσει σωστά και έχετε εγκαταστήσει όλα τα 
απαιτούμενα προγράμματα λογισμικού.

Το λογισμικό Adobe Dreamweaver CS5 δεν περιλαμβάνεται στο δίσκο και 
πρέπει να το προμηθευτείτε ξεχωριστά ως αυτόνομο προϊόν ή ως μέρος 
μιας από τις εκδόσεις Creative Suite. Για πλήρεις οδηγίες για την εγκατάσταση 
του λογισμικού, διαβάστε το αρχείο “How to Install” στο CD του βιβλίου.

Αντιγραφή των αρχείων του βιβλίου
Το CD του βιβλίου περιλαμβάνει φακέλους που περιέχουν όλα τα ηλεκτρο-
νικά αρχεία για τα μαθήματα. Κάθε μάθημα έχει το δικό του φάκελο ο οποίος 
περιέχει τα αρχεία και τους πόρους που θα χρειαστείτε για να ολοκληρώσετε 
το μάθημα. Πρέπει να εγκαταστήσετε αυτούς τους φακέλους στο σκληρό 
δίσκο σας, ώστε να μπορείτε να χρησιμοποιήσετε τα αρχεία για τα μαθή-
ματα. Προτείνουμε να αποθηκεύετε όλους τους φακέλους των μαθημάτων 
στο σκληρό δίσκο σας, αλλά αν θέλετε να κάνετε οικονομία χώρου στο σκληρό 
δίσκο σας, μπορείτε να εγκαταστήσετε τους φακέλους των μαθημάτων που 
χρειάζεστε. Είναι ιδιαίτερα σημαντικό να αποθηκεύσετε όλους τους φακέλους 
των μαθημάτων σε ένα φάκελο μέσα στο δίσκο σας. Εάν ακολουθήσετε την 
προτεινόμενη σειρά μαθημάτων, αυτός ο βασικός φάκελος θα αποτελέσει 
τον τοπικό ριζικό φάκελο, όπως θα περιγράψουμε στο Μάθημα 4.

Για να εγκαταστήσετε τα αρχεία του βιβλίου:

1  Εισάγετε το CD του βιβλίου στη μονάδα οπτικού δίσκου του υπολογιστή 
σας.

2  Πηγαίνετε στη μονάδα CD/DVD στον υπολογιστή σας.

3  Εάν σκοπεύετε να ολοκληρώσετε όλα τα μαθήματα του βιβλίου με τη 
σειρά, μεταφέρετε το φάκελο Lessons στο σκληρό δίσκο του υπολογιστή 
σας. ∆ιαφορετικά, πηγαίνετε στο βήμα 5.

 Ο φάκελος Lessons περιέχει όλους τους ξεχωριστούς φακέλους για κάθε 
μάθημα και άλλους πόρους που απαιτούνται για την εκπαίδευση.

4  Μετονομάστε το φάκελο Lessons σε DW-CIB.

 Αυτός ο φάκελος θα είναι ο τοπικός ριζικός φάκελος.

5  Εάν επιθυμείτε να εκτελέσετε ένα ή περισσότερα μαθήματα ξεχωριστά, 
αντιγράψτε κάθε φάκελο μαθήματος στη μονάδα του σκληρού δίσκου 
σας, όπως πρέπει. Στη συνέχεια, προχωρήστε στην ενότητα “Γρήγορη 
εκκίνηση” για περισσότερες οδηγίες.

 ∆εν μπορείτε να χρησιμοποιήσετε αρχεία και φακέλους ενός μαθήματος 
για άλλο μάθημα.
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Προτεινόμενη σειρά μαθημάτων
Ο σκοπός του βιβλίου είναι να σας οδηγήσει στην εκμάθηση όλων των πραγ-
μάτων που χρειάζεστε για σχεδίαση, ανάπτυξη και παραγωγή website σε 
εισαγωγικό και μεσαίο επίπεδο. Κάθε νέο μάθημα βασίζεται σε προηγούμενες 
ασκήσεις, χρησιμοποιώντας τα αρχεία και τους πόρους που χρησιμοποιήσατε 
για να αναπτύξετε ένα ολόκληρο website. Προτείνουμε να ακολουθήσετε τα 
μαθήματα με τη σειρά προκειμένου να ολοκληρώσετε ένα επιτυχημένο έργο 
και να καταλάβετε καλύτερα όλες τις πτυχές της σχεδίασης στο web.

Το ιδανικό σενάριο εκπαίδευσης ξεκινά από το Μάθημα 1 και προχωρά μέσα απ' 
όλο το βιβλίο ως το Μάθημα 17. Επειδή κάθε μάθημα δημιουργεί απαραίτητα 
αρχεία και υλικό για το επόμενο, όταν ξεκινήσετε μ' αυτό το σενάριο, δεν θα 
πρέπει να παραλείψετε κανένα μάθημα, ούτε μεμονωμένες ασκήσεις. Ενώ είναι 
ιδανική, αυτή η μέθοδος ίσως δεν είναι η πιο πρακτική για κάθε χρήστη. Έτσι, 
αν θέλετε, μπορείτε να παρακολουθήσετε ξεχωριστά μαθήματα χρησιμοποιώ-
ντας τη μέθοδο γρήγορης εκκίνησης που περιγράφουμε στην επόμενη ενότητα.

Γρήγορη εκκίνηση
Για χρήστες που δεν έχουν το χρόνο ή τη διάθεση να παρακολουθήσουν κάθε 
μάθημα του βιβλίου με τη σειρά, ή έχουν δυσκολίες σε ένα συγκεκριμένο μάθημα, 
περιλαμβάνεται μια μέθοδος γρήγορης εκκίνησης που θα διευκολύνει την ολο-
κλήρωση μεμονωμένων μαθημάτων ενός ή εκτός σειράς. Από τη στιγμή που 
θα αρχίσετε να χρησιμοποιείτε τη μέθοδο γρήγορης εκκίνησης, θα πρέπει να 
τη χρησιμοποιήσετε σε όλα τα επόμενα μαθήματα. Για παράδειγμα, εάν θέλετε 
να δοκιμάσετε τη γρήγορη εκκίνηση στο Μάθημα 6, θα πρέπει να κάνετε το 
ίδιο και για το Μάθημα 7. Σε πολλές περιπτώσεις, τα απαραίτητα αρχεία για 
επόμενες ασκήσεις δημιουργήθηκαν σε προηγούμενα μαθήματα και ασκήσεις 
και ίσως δεν υπάρχουν σε ένα περιβάλλον γρήγορης εκκίνησης.

Κάθε φάκελος μαθήματος περιέχει όλα τα αρχεία και τους πόρους που απαι-
τούνται για την ολοκλήρωση των ασκήσεων που περιέχονται μέσα σ' αυτό 
το μάθημα. Κάθε φάκελος περιέχει ολοκληρωμένα αρχεία, αρχεία σε διάφορα 
στάδια ολοκλήρωσης και προσαρμοσμένα αρχεία προτύπων και βιβλιοθήκης. 
Αυτοί οι φάκελοι μοιάζουν να περιέχουν φαινομενικά επαναλαμβανόμενα 
περιεχόμενα. Αλλά αυτά τα διπλά αρχεία και πόροι, στις περισσότερες περι-
πτώσεις, δεν μπορούν να χρησιμοποιηθούν αντί των παρόμοιών τους σε άλλα 
μαθήματα και ασκήσεις. Αν το κάνετε αυτό, πιθανώς δεν θα καταφέρετε να 
επιτύχετε το στόχο της άσκησης.

Η μέθοδος γρήγορης εκκίνησης για την ολοκλήρωση μεμονωμένων μαθημάτων 
αντιμετωπίζει κάθε φάκελο σαν ένα ανεξάρτητο website. Για να την ακολου-
θήσετε για ένα μάθημα, αντιγράψτε το φάκελο μαθήματος στο σκληρό δίσκο 
σας και δημιουργήστε ένα νέο site γι' αυτό το μάθημα χρησιμοποιώντας το 
παράθυρο διαλόγου Site Setup. ∆ιατηρήστε τα site γρήγορης εκκίνησης και τους 
πόρους σας στους αρχικούς φακέλους, ώστε να αποφευχθούν συγκρούσεις. 
Μία πρόταση είναι να οργανώσετε τους φακέλους μαθημάτων, όπως και τους 
φακέλους των δικών σας site, σε έναν κύριο φάκελο με το όνομα webs ή sites 
κοντά στη ρίζα του σκληρού δίσκου σας. Θα πρέπει όμως να αποφύγετε τη 
χρήση του φακέλου εφαρμογών του Dreamweaver ή οποιωνδήποτε φακέλων 
που περιέχουν ένα διακομιστή web, όπως είναι οι Apache, ColdFusion ή Internet 
Information Services (IIS).
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Μπορείτε αν θέλετε να χρησιμοποιήσετε τη μέθοδο γρήγορης εκκίνησης για 
όλα τα μαθήματα.

Για να ετοιμάσετε ένα site γρήγορης εκκίνησης, κάντε τα παρακάτω:

1  Επιλέξτε Site > New Site.

 Θα ανοίξει το παράθυρο διαλόγου Site Setup.

2  Στο πεδίο Site Name, εισάγετε το όνομα του μαθήματος, όπως les-
son06.

3  ∆ίπλα στο πεδίο Local Site Folder, κάντε κλικ στο εικονίδιο Browse ( ). 
Πηγαίνετε στο φάκελο του μαθήματος που αντιγράψατε από τον δίσκο 
του βιβλίου και κάντε κλικ στο Select/Choose.

4  Κάντε κλικ στο βέλος ( ) δίπλα στη κατηγορία Advanced Settings προ-
κειμένου να αποκαλύψετε τις καρτέλες που υπάρχουν εκεί. Επιλέξτε 
την κατηγορία Local Info.

5  ∆ίπλα στο πεδίο Default Images Folder, κάντε κλικ στο εικονίδιο Browse. 
Όταν ανοίξει το παράθυρο διαλόγου, πηγαίνετε στο φάκελο Images 
που περιλαμβάνεται μέσα στο φάκελο του μαθήματος και κάντε κλικ 
στο Select/Choose.

6  Στο παράθυρο διαλόγου Site Setup, κάντε κλικ στο Save.

7  Το όνομα του ενεργού website θα εμφανιστεί στο αναδυόμενο μενού 
Show της παλέτας Files. Εάν χρειαστεί, πατήστε Ctrl-Shift-F/Cmd-Shift-F 
για να ανοίξετε την παλέτα Files και επιλέξτε το επιθυμητό website από 
το μενού Show.

Αυτά τα βήματα θα πρέπει να επαναληφθούν για κάθε μάθημα για το οποίο 
επιθυμείτε τη γρήγορη εκκίνηση. Για μια πιο αναλυτική περιγραφή για την 
ετοιμασία ενός site στο Dreamweaver, διαβάστε το Μάθημα 4, “Γρήγορο 
ξεκίνημα”.

∆ιαμόρφωση του χώρου εργασίας
Το Dreamweaver περιλαμβάνει αρκετούς χώρους εργασίας που μπορούν 
να φιλοξενήσουν διάφορες διαμορφώσεις υπολογιστή και ξεχωριστές ροές 
εργασίας. Γι' αυτό το βιβλίο, ο καλύτερος χώρος εργασίας που μπορείτε να 
χρησιμοποιήσετε είναι η ρύθμιση Designer.

1  Στο Dreamweaver CS5, βρείτε τη γραμμή εφαρμογής, Application. Εάν 
χρειάζεται, επιλέξτε Window > Application Bar για να την εμφανί-
σετε.

2  Ο προεπιλεγμένος χώρος εργασίας ονομάζεται Designer. Εάν δεν εμφα-
νίζεται, χρησιμοποιήστε το αναδυόμενο μενού στη γραμμή Application 
για να τον επιλέξετε.

Οι περισσότερες από τις εικόνες του βιβλίου εμφανίζουν το χώρο εργασίας 
Designer. Όταν ολοκληρώσετε τα μαθήματα του βιβλίου, πειραματιστείτε 
με άλλους χώρους εργασίας μέχρι να βρείτε αυτόν που σας ταιριάζει.

Για μια πιο αναλυτική περιγραφή των χώρων εργασίας του Dreamweaver, 
διαβάστε το Μάθημα 1, “Προσαρμογή του χώρου εργασίας.”
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 ● Σημείωση: Εάν 
το Dreamweaver 
διαπιστώσει ότι 
δεν είστε συνδεδε-
μένοι στο Internet 
όταν ανοίγετε την 
εφαρμογή, επιλέξτε 
Help > Dreamweaver 
Help προκειμένου να 
ανοίξετε τις σελίδες 
Help HTML που εγκα-
θίστανται μαζί με το 
Dreamweaver. Για πιο 
ενημερωμένες πλη-
ροφορίες, ανατρέξτε 
στην ηλεκτρονική 
βοήθεια στο Internet ή 
κατεβάστε το τρέχον 
αρχείο PDF Dream-
weaver Help.

 ● Σημείωση: Για να 
επιλέξετε προτιμή-
σεις για μελλοντικές 
ενημερώσεις, κάντε 
κλικ στο Preferences. 
Μπορείτε να επιλέ-
ξετε πόσο συχνά το 
Adobe Updater θα 
πρέπει να ελέγχει αν 
υπάρχουν νέες ενη-
μερώσεις, να αναγνω-
ρίζει τις εφαρμογές 
που ενημερώνονται 
και αν θα τις λαμβάνει 
αυτόματα. Κάντε κλικ 
στο OK προκειμένου 
να δεχτείτε τις νέες 
ρυθμίσεις.
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Οδηγίες για Windows και Macintosh
Στις περισσότερες περιπτώσεις, το Dreamweaver εκτελείται με τον ίδιο 
τρόπο στα Windows και στο Mac OS X. Μικρές διαφορές υπάρχουν μεταξύ 
των δύο εκδόσεων, κυρίως λόγω θεμάτων που αφορούν τις δύο πλατφόρμες 
και δεν ελέγχονται από το πρόγραμμα. Οι περισσότερες είναι απλά διαφορές 
στις συντομεύσεις πληκτρολογίου, στον τρόπο εμφάνισης των παραθύ-
ρων διαλόγου και στην ονομασία των κουμπιών. Τα στιγμιότυπα οθόνης 
επίσης διαφέρουν στο βιβλίο για τις δύο πλατφόρμες. Όταν διαφέρουν 
συγκεκριμένες εντολές, υπάρχει σχετική παρατήρηση μέσα στο κείμενο. Οι 
εντολές των Windows αναφέρονται πρώτες και ακολουθούν οι αντίστοιχες 
σε Macintosh, όπως Ctrl-C/Cmd-C. Κοινές συντομεύσεις χρησιμοποιούνται 
για όλες τις εντολές, όποτε αυτό είναι δυνατό, ως εξής:

WINDOWS MACINTOSH

Control = Ctrl Command = Cmd

Alternate = Alt Option = Opt

Πώς θα βρείτε πληροφορίες για το Dreamweaver
Για πλήρεις, ενημερωμένες πληροφορίες για τις παλέτες, τα εργαλεία και 
άλλα χαρακτηριστικά του Dreamweaver, επισκεφτείτε το website της. Επι-
λέξτε Help > Dreamweaver Help. Θα ανοίξει η εφαρμογή Adobe Help και θα 
δείτε αυτόματα τα τελευταία αρχεία βοήθειας από το website της Adobe 
Community Help. Αυτά τα αρχεία αποθηκεύονται τοπικά στον υπολογιστή 
σας, ώστε να μπορείτε να τα προσπελάσετε ακόμα κι όταν δεν είστε συνδε-
δεμένοι στο Internet. Μπορείτε επίσης να κατεβάσετε μια έκδοση PDF των 
αρχείων Dreamweaver Help από την εφαρμογή Adobe Help.

Για πρόσθετους ενημερωτικούς πόρους, όπως συμβουλές, τεχνικές και τις 
τελευταίες πληροφορίες για το προϊόν, επισκεφτείτε τη σελίδα www.adobe.
com/support/dreamweaver για να προσπελάσετε τη σελίδα βοήθειας της 
κοινότητας της Adobe.

Έλεγχος για ενημερώσεις
Η Adobe ανά τακτά διαστήματα παρέχει ενημερώσεις λογισμικού. Μπορείτε 
να αποκτήσετε αυτές τις ενημερώσεις χρησιμοποιώντας το Adobe Updater, 
εάν έχετε ενεργή σύνδεση στο Internet.

1  Στο Dreamweaver, επιλέξτε Help > Updates. Το Adobe Updater ελέγχει 
αυτόματα για υπάρχουσες ενημερώσεις για το λογισμικό σας Adobe.

2  Στο παράθυρο διαλόγου Adobe Updater, επιλέξτε τις ενημερώσεις 
που θέλετε να εγκαταστήσετε και κάντε κλικ στο Download And Install 
Updates ώστε να τις εγκαταστήσετε.
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Πρόσθετοι πόροι
Το Adobe Dreamweaver CS5 Βήμα προς Βήμα δεν αποσκοπεί να αντικατα-
στήσει την τεκμηρίωση που συνοδεύει το πρόγραμμα, ούτε είναι μία ανα-
λυτικότατη αναφορά για όλα τα χαρακτηριστικά του προγράμματος. Μόνο 
οι εντολές και οι επιλογές που χρησιμοποιούνται στα μαθήματα εξηγούνται 
σε αυτό το βιβλίο. Για πιο αναλυτικές πληροφορίες για τα χαρακτηριστικά 
του προγράμματος, ανατρέξτε στις παρακάτω πηγές:

Adobe Community Help: Η βοήθεια της κοινότητας, Community Help, 
συγκεντρώνει ενεργούς χρήστες προϊόντων της Adobe, μέλη ομάδων προ-
ϊόντων της Adobe, συγγραφείς και ειδικούς προκειμένου να σας δώσει τις 
πιο χρήσιμες, σχετικές και ενημερωμένες πληροφορίες για προϊόντα της 
Adobe. Είτε ψάχνετε για ένα δείγμα κώδικα είτε για μιαν απάντηση σε ένα 
πρόβλημα, είτε έχετε μια ερώτηση για το λογισμικό είτε θέλετε να μοιραστείτε 
μια χρήσιμη συμβουλή ή συνταγή, θα επωφεληθείτε από το Community 
Help. Τα αποτελέσματα αναζήτησης θα σας δείχνουν υλικό όχι μόνο από 
την Adobe, αλλά και από την κοινότητα.

Με το Adobe Community Help μπορείτε να κάνετε τα εξής:

•  Προσπέλαση ενημερωμένων οριστικών αναφορών εντός και εκτός 
δικτύου

•  Εύρεση του πιο σχετικού υλικού που συνεισφέρουν ειδικοί της κοινό-
τητας της Adobe, από το Adobe.com ή από αλλού

•  Σχόλια και βαθμολογίες για υλικό στην κοινότητα της Adobe 

•  Λήψη περιεχομένου βοήθειας απευθείας στον υπολογιστή σας για 
χρήση εκτός Internet

•  Εύρεση σχετικού υλικού με δυναμικά εργαλεία αναζήτησης και πλοή-
γησης

Για να προσπελάσετε το Community Help: Εάν έχετε οποιοδήποτε προϊόν 
CS5 της Adobe, τότε έχετε ήδη την εφαρμογή Community Help. Για να ενεργο-
ποιήσετε τη βοήθεια, επιλέξτε Help > Dreamweaver Help. Αυτή η βοηθητική 
εφαρμογή σάς επιτρέπει να εκτελείτε αναζητήσεις και να περιεργάζεστε το 
υλικό της Adobe και της κοινότητας, αλλά και να σχολιάζετε και να βαθμολο-
γείτε οποιοδήποτε άρθρο, όπως θα κάνατε και στο πρόγραμμα περιήγησης. 
Ωστόσο, μπορείτε να λάβετε το Adobe Help και υλικό της γλώσσας αναφοράς 
στον υπολογιστή σας, για χρήση εκτός δικτύου, αλλά μπορείτε επίσης να 
εγγραφείτε συνδρομητές σε νέες ενημερώσεις υλικού (τις οποίες μπορείτε 
να λαμβάνετε αυτόματα), ώστε να έχετε πάντα το πιο ενημερωμένο υλικό 
για τα προϊόντα της Adobe πάντα. Μπορείτε να λάβετε την εφαρμογή από 
τη σελίδα www.adobe.com/support/chc/index.html.

Το υλικό της Adobe ανανεώνεται βάσει ανάδρασης και συνεισφορών στην 
κοινότητα. Μπορείτε να συνεισφέρετε με πολλούς τρόπους: προσθέστε 
σχόλια σε υλικό ή φόρουμ, συμπεριλαμβάνοντας συνδέσεις για υλικό που 
υπάρχει στο web, δημοσιεύστε το δικό σας υλικό χρησιμοποιώντας το 
εργαλείο Community Publishing και συμμετέχετε στην εφαρμογή Cookbook 
Recipes. Ανακαλύψτε πώς μπορείτε να συνεισφέρετε στη διεύθυνση www.
adobe.com/community/publishing/download.html.
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Επισκεφτείτε το http://community.adobe.com/help/profile/faq.html για απα-
ντήσεις σε συχνές ερωτήσεις για το Community Help.

Adobe Dreamweaver Help and Support: Στη σελίδα www.adobe.com/sup-
port/dreamweaver θα βρείτε και θα περιηγηθείτε στο υλικό του Help and 
Support στο site της Adobe.

Adobe TV: Το site http://tv.adobe.com είναι ένας ηλεκτρονικός πόρος με βίντεο 
για οδηγίες από ειδικούς και υλικό, το οποίο θα σας εμπνεύσει να δημιουρ-
γήσετε διάφορα έργα με προϊόντα της Adobe, όπου συμπεριλαμβάνεται και 
ένα κανάλι How To που θα σας βοηθήσει να ξεκινήσετε.

Adobe Design Center: Η διεύθυνση www.adobe.com/designcenter προσφέρει 
αναλυτικά άρθρα για θέματα σχεδίασης, μια συλλογή με τα έργα κορυφαίων 
σχεδιαστών, βοηθήματα και άλλα.

Adobe Developer Connection: Στη διεύθυνση www.adobe.com/devnet θα 
βρείτε τεχνικά άρθρα, δείγματα κώδικα και βίντεο με οδηγίες που καλύπτουν 
προϊόντα και τεχνολογίες προγραμματισμού της Adobe.

Πόροι για εκπαιδευτές: Στη διεύθυνση www.adobe.com/education θα βρείτε 
τρία δωρεάν προγράμματα που ακολουθούν μια ολοκληρωμένη προσέγγιση 
στη διδασκαλία του λογισμικού της Adobe και τα οποία μπορούν να χρησι-
μοποιηθούν για την προετοιμασία εξετάσεων Adobe Certified Associate.

∆είτε επίσης τις παρακάτω χρήσιμες συνδέσεις:

Χώροι συζήτησης χρηστών της Adobe: http://forums.adobe.com  -- σας 
επιτρέπει να παρεμβαίνετε σε συζητήσεις μεταξύ ομότιμων, να κάνετε 
ερωτήσεις και να παίρνετε απαντήσεις για προϊόντα της Adobe.

Χώρος αγορών και ανταλλαγών της Adobe: www.adobe.com/cfusion/
exchange -- ένας κεντρικός πόρους για εύρεση εργαλείων, υπηρεσιών, επε-
κτάσεων, δειγμάτων κώδικα και πολλών άλλων πραγμάτων που συμπλη-
ρώνουν και επεκτείνουν τα προγράμματά σας της Adobe.

Η αρχική σελίδα του προγράμματος Dreamweaver CS5: www.adobe.com/
products/dreamweaver

Εργαστήρια της Adobe: http://labs.adobe.com – σας δίνει πρόσβαση σε 
καινοτομίες τεχνολογίας αιχμής, όπως και σε φόρουμ όπου μπορείτε να 
αλληλεπιδράσετε με ομάδες ανάπτυξης της Adobe που κατασκευάζουν 
αυτήν την τεχνολογία, αλλά και από άλλα μέλη της κοινότητας με παρόμοιες 
ανησυχίες.
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Πιστοποίηση από την Adobe
Τα προγράμματα πιστοποίησης και εκπαίδευσης της Adobe έχουν σχεδια-
στεί έτσι, ώστε να βοηθούν τους πελάτες της Adobe να βελτιώνουν και να 
προω θούν τις δεξιότητές τους. Υπάρχουν τέσσερα επίπεδα πιστοποίησης:

• Adobe Certified Associate (ACA)

• Adobe Certified Expert (ACE)

• Adobe Certified Instructor (ACI)

• Adobe Authorized Training Center (AATC)

Το πρόγραμμα Adobe Certified Associate (ACA) πιστοποιεί ότι όσοι το ολο-
κληρώνουν με επιτυχία κατέχουν τις βασικές γνώσεις που είναι απαραίτητες 
για σχεδίαση, κατασκευή και διατήρηση αποτελεσματικής επικοινωνίας 
χρησιμοποιώντας διάφορες μορφές ψηφιακών μέσων.

Το πρόγραμμα Adobe Certified Expert είναι ένας τρόπος για τους εξειδικευ-
μένους χρήστες να αναβαθμίζουν τα διαπιστευτήριά τους. Μπορείτε να 
χρησιμοποιήσετε την πιστοποίηση της Adobe ως καταλύτη για την αύξηση 
του μισθού σας, την εύρεση εργασίας ή την προώθηση της εμπειρία σας.

Εάν είστε εκπαιδευτής επιπέδου ACE, τα προγράμματα Adobe Certified 
Instructor ενισχύουν τις δεξιότητές σας και σας παρέχουν πρόσβαση στην 
ευρεία γκάμα των πόρων της Adobe. Τα κέντρα εκπαίδευσης Adobe Autho-
rized Training Centers παρέχουν σειρές μαθημάτων και εκπαίδευσης για τα 
προϊόντα της Adobe, μόνο με πιστοποιημένους εκπαιδευτές της Adobe. Θα 
βρείτε έναν κατάλογο που αφορά στα κέντρα AATC στη διεύθυνση http://
partners.adobe.com/public/partnerfinder/tp/show_find.do.

Για πληροφορίες για τα προγράμματα πιστοποίησης της Adobe, επισκε-
φτείτε το www.adobe.com/support/certification/.

00_CONTENTS dream-cs4.indd   xviii00_CONTENTS dream-cs4.indd   xviii 18/10/2010   6:00:43 μμ18/10/2010   6:00:43 μμ



xixΕισαγωγή

Επιταχύνετε τη ροή εργασίας σας με το Adobe CS Live
Το Adobe CS Live είναι ένα σύνολο από ηλεκτρονικές υπηρεσίες που εκμεταλλεύονται τη σύνδεση στο web 
και ενσωματώνονται στο Adobe Creative Suite 5 για απλοποίηση της δημιουργικής διαδικασίας επιμέλειας, 
για επιτάχυνση των δοκιμών συμβατότητας ενός website, για παράδοση σημαντικών πληροφοριών από 
χρήστες του web και άλλα, τα οποία σας επιτρέπουν να εστιάσετε στη δημιουργία των πιο σημαντικών 
έργων σας. Οι υπηρεσίες του CS Live παρέχονται δωρεάν για περιορισμένο χρόνο* και μπορούν να προ-
σπελαστούν μέσω Internet ή μέσα από τις εφαρμογές του Creative Suite 5.

Το Adobe BrowserLab αφορά τους σχεδιαστές και προγραμματιστές του web που πρέπει να 
εξετάζουν και να δοκιμάζουν τις ιστοσελίδες τους σε πολλαπλά προγράμματα περιήγησης και 
λειτουργικά συστήματα. Αντίθετα από άλλες λύσεις συμβατότητας προγραμμάτων περιήγησης, 

το BrowserLab δημιουργεί στιγμιότυπα οθόνης εικονικά μετά από ζήτηση του χρήστη, με πολλαπλά εργα-
λεία προβολής και διάγνωσης, και μπορεί να χρησιμοποιηθεί με το Dreamweaver CS5 για προεπισκόπηση 
τοπικού υλικού και διαφορετικών καταστάσεων διαδραστικών σελίδων. Ως μια ηλεκτρονική υπηρεσία, 
το BrowserLab έχει ταχείς κύκλους ανάπτυξης, με μεγαλύτερη ευελιξία για εκτεταμένη υποστήριξη προ-
γραμμάτων περιήγησης και αναβαθμισμένες λειτουργίες.

Το Adobe CS Review αφορά δημιουργικούς επαγγελματίες που θέλουν ένα νέο επίπεδο απο-
τελεσματικότητας στη δημιουργική διαδικασία επιμέλειας. Αντίθετα από άλλες υπηρεσίες που 
προσφέρουν ηλεκτρονικές δυνατότητες εξέτασης δημιουργικού υλικού, μόνο το CS Review σας 

επιτρέπει να δημοσιεύσετε μια κριτική στο web απευθείας μέσα από τα προγράμματα InDesign, Pho-
toshop, Photoshop Extended και Illustrator και να βλέπετε σχόλια άλλων σχολιαστών μέσα στην αρχική 
εφαρμογή του Creative Suite.

Το Acrobat.com αφορά δημιουργικούς επαγγελματίες που πρέπει να εργάζονται με ομάδες συνα-
δέλφων και πελατών προκειμένου να οδηγήσουν ένα δημιουργικό έργο από μια περίληψη στο 
τελικό προϊόν. Το Acrobat.com είναι ένα σύνολο από ηλεκτρονικές υπηρεσίες όπως διάσκεψη στο 

web, ηλεκτρονική κοινοχρησία αρχείων και χώρους εργασίας. Αντίθετα από τη συνεργασία μέσω e-mail και 
από την παρακολούθηση χρονοβόρων συσκέψεων, το Acrobat.com φέρνει τους ανθρώπους στη δουλειά 
σας αντί να στέλνει αρχεία σε ανθρώπους, ώστε να μπορείτε να επιταχύνετε την διαδικαστική πλευρά 
της δημιουργικής διεργασίας μαζί με τους συνεργάτες σας, από οποιαδήποτε θέση.

Το Adobe Story αφορά δημιουργικούς επαγγελματίες, παραγωγούς και συγγραφείς που εργάζο-
νται ή συνεργάζονται με δέσμες ενεργειών. Το Story είναι ένα εργαλείο συνεργατικής ανάπτυξης 
δεσμών ενεργειών που μετατρέπει τις δέσμες ενεργειών σε μεταδεδομένα, τα οποία μπορούν 

να χρησιμοποιηθούν με τα εργαλεία Adobe CS5 Production Premium για καλύτερη οργάνωση των ροών 
εργασίας και για δημιουργία πόρων σε βίντεο.

Το SiteCatalyst NetAverages αφορά επαγγελματίες του web και ανθρώπους που εργάζονται 
εκτός γραφείου, οι οποίοι θέλουν να βελτιστοποιήσουν τα έργα τους για ευρύτερα κοινά. Το 
NetAverages παρέχει τεχνογνωσία για το πώς οι χρήστες μπορούν να προσπελάσουν το web, 

κάτι που συμβάλλει στη μείωση των τυχαίων αποφάσεων και της εικασίας στην αρχή της δημιουργικής 
διεργασίας. Μπορείτε να προσπελάσετε συγκεντρωτικά δεδομένα χρηστών, όπως τύπο προγράμματος 
περιήγησης, λειτουργικό σύστημα, προφίλ φορητής συσκευής, ανάλυση οθόνης και άλλα, τα οποία θα 
σας ωφελήσουν στο μέλλον. Τα δεδομένα προέρχονται από τη δραστηριότητα των επισκεπτών σε site 
πελατών που συμμετέχουν στο πρόγραμμα Omniture SiteCatalyst. Αντίθετα από άλλες πηγές πληροφο-
ριών για το web, το NetAverages προβάλλει δεδομένα με καινοτόμο τρόπο χρησιμοποιώντας το Flash, 
δημιουργώντας μια ισχυρή και ενδιαφέρουσα εμπειρία, την οποία κάποιος μπορεί να ακολουθήσει άνετα.

Μπορείτε να προσπελάσετε το CS Live με τρεις διαφορετικούς τρόπους:
1  Προετοιμάστε την πρόσβαση όταν δηλώνετε τα προϊόντα σας Creative Suite 5 και αποκτήστε δωρεάν 
πρόσβαση που περιλαμβάνει όλα τα χαρακτηριστικά και τα οφέλη της ροής εργασίας που φέρει η 
χρήση του CS Live με τα προϊόντα CS5.

2  Εγγραφτείτε μέσω Internet και αποκτήστε δωρεάν πρόσβαση στις υπηρεσίες CS Live για περιορισμένο χρόνο. 
Σημειώστε ότι αυτή η επιλογή δεν σας παρέχει πρόσβαση στις υπηρεσίες μέσα από τα προϊόντα σας.

3  Οι δοκιμαστικές εκδόσεις των προϊόντων περιλαμβάνουν δωρεάν δοκιμή 30 ημερών των υπηρεσιών 
του CS Live.

*Οι υπηρεσίες CS Live παρέχονται δωρεάν για περιορισμένο χρόνο. Για λεπτομέρειες, επισκεφτείτε το www.adobe.
com/go/cslive.
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